Navigating Among the Objects in an Access Database
The objects in an Access database are the main components that are created and used to make the database function. 
The four main object types are tables, queries, forms, and reports. Two other object types, macros and modules, are used less frequently.
A field is the smallest data element contained in a table. Fields define the type of data that is collected, for example, text, numeric, or date. A field may be required or optional.
A record is a complete set of all of the data elements (fields) about one person, place, event, or concept.
A table, the foundation of every database, is a collection of related records.
A database consists of one or more tables to store data, one or more forms to enter data into the tables, and one or more reports to output the table data as organized information.
The main functions of a database are to collect data, to store data logically, to manipulate data to make it more useful, and to output the data to the screen and printed reports.
Databases also export data to files so the files can be imported by other databases or other information-processing systems
Examine the Access Interface
The Navigation Pane organizes and lists the database objects in an Access database.
As stated earlier, six types of objects—tables, queries, forms, reports, macros, and modules— can exist in a database.
Most databases contain multiple tables, queries, forms, and reports. Tables store the data, forms enable users to enter information into the tables, reports enable users to display data in an organized format, and queries enable users to ask questions about the data.
The Access Ribbon contains the icons that help you perform the database functions to maintain a database.
Work with Table Views
The Datasheet view is a grid containing columns (fields) and rows (records), similar to an Excel spreadsheet. You can view, add, edit, and delete records in the Datasheet view
Design view is used to create and modify a table’s design by specifying the fields it will contain, the fields’ data types, and their associated properties. Data types define the type of data that will be stored in a field, such as currency, numeric, text, etc.
The primary key is the field (or combination of fields) that uniquely identifies each record in a table
No system, no matter how sophisticated, can produce valid output from invalid input. Access database systems are built to anticipate data entry errors. These systems contain table validation rules created to prevent invalid data entry. 
Two types of validation rules exist: those built into Access and those a developer creates specifically for a database. Ex:  Access will automatically prevent you from adding a new record with the same primary key as an existing record; Access does not allow you to enter text or numeric data into a date field
Use Forms, Queries, and Reports
The tables are the heart of any database because they contain the actual data. The other objects in a database—such as forms, queries, and reports—are based on one or more underlying tables
A form is an object that enables you to enter, modify, or delete table data. A form enables you to manipulate data in the same manner that you would in a table’s Datasheet view. The difference is that you can create a form that will limit the user to viewing only one record at a time.
A query is a question that you ask about the data in the tables of your database. The answer is shown in the query results. A query can be used to display only records that meet a certain criterion and only the fields that are required
A criterion (criteria, pl) is a number, a text phrase, or an expression used to filter the records in a table. If you need the names of all the suppliers in Quebec, you can set the supplier’s state/province criterion to Quebec. The results would yield only those suppliers from Quebec. Query results are in Datasheet view and are similar in appearance to the underlying table, except that the query contains selected records and/or selected fields for those records. The query also may list the records in a different sequence from that of the table.
A report contains professional-looking formatted information from underlying tables or queries
Understanding the Difference Between Working in Storage and in Memory
Word, Excel, and PowerPoint all work primarily from memory. In those applications, your work is not automatically saved to your hard drive unless you click the save icon. Access, on the other hand, works primarily from storage. With an Access database file, several users can work in the same file at the same time
Practising Good Database File Management
Access runs best from a local disk drive or network disk drive because those drives have sufficient access speed to support the software. Access speed measures the time it takes for the storage device to make the file content available for use. Your next best storage option is a thumb drive, also known as a USB jump drive, a flash drive, a pen drive, or a stick drive
Backing Up, Compacting, and Repairing Access Files
Access provides two utilities to help protect the data within a database: Compact and Repair and Backup. These two functions both help protect your data, but they each serve a different purpose. Compact and Repair reduces the size of the database. Backup creates a duplicate copy of the database
Compact and Repair a Database
All Access databases have a tendency to expand with everyday use. Entering data, creating queries, running reports, deleting objects, and adding indexes will all cause a database file to expand. This growth may increase storage requirements and may also impact database performance.
When you run the Compact and Repair utility, it creates a new database file behind the scenes and copies all the objects from the original database into the new one. As it copies the objects into the new file, Access will remove temporary objects and unclaimed space due to deleted objects, resulting in a smaller database file. Compact and Repair will also defragment a fragmented database file if needed.
Back Up a Database
To back up files, click the File tab, and then click Save & Publish from the list of options. From the list of Save & Publish options, double-click Back Up Database, and the Save As dialog box opens.
Filters, Sorts, and Access Versus Excel
Access provides you with many tools that you can use to identify and extract only the data needed at the moment.


Creating Filters
A filter displays a subset of records based on specified criteria.
A filter works with either a table’s datasheet or a query’s datasheet. You can use filters to analyze data quickly. Applying a filter does not delete any records; filters only hide records that do not match the criteria. 
Filter by Selection selects only the records that match preselected single criteria 
Filter by Form offers a more versatile way to select a subset of records, including the use of comparison operators.
Filters enable you to obtain information from a database quickly without creating a query or a report.
Sorting Table Data on One or More Fields
You can also change the order of the information by sorting by one or more fields.
A sort lists records in a specific sequence, such as alphabetically by last name or by ascending
EmployeeID.
Ascending sorts a list of text data in alphabetical order or a numeric list in lowest to highest order. 
Descending sorts a list of text data in reverse alphabetical order or a numeric list in highest to lowest order.
The operations can be done in any order; that is, you can filter a table to show only selected records, and then sort the filtered table to display the records in a certain order. Conversely, you can sort a table first and then apply a filter. It does not matter which operation is performed first. You can also filter the table further by applying a second, a third, or more criteria
You can also click Toggle Filter at any time to remove all filters and display all of the records in the table. Filters are a temporary method for examining table data. If you close the filtered table and then reopen it, the filter will be removed, and all of the records will be restored.
Knowing When to Use Access or Excel to Manage Data
Select the Software to Use
Access provides built-in tools to help organize data better than Excel.
A relationship is a connection between two tables using a common field. The benefit of a relationship is to efficiently combine data from related tables for the purpose of creating queries, forms, and reports. Relationships are the reason why Access is referred to as a relational database.
Use Access
You should use Access to manage data when you:
• Require multiple related tables to store your data.
• Have a large amount of data.
• Need to connect to and retrieve data from external databases, such as Microsoft SQL
Server.
• Need to group, sort, and total data based on various parameters.
• Have an application that requires multiple users to connect to one data source at the
same time.
Use Excel
You should use Excel to manage data when you:
• Only need one worksheet to handle all of your data (i.e., you do not need multiple
worksheets).
• Have mostly numeric data—for example, you need to maintain an expense
statement.
• Require subtotals and totals in your worksheet.
• Want to primarily run a series of “what if” scenarios on your data.
• Need to create complex charts and/or graphs.
Relational Database
Access is known as a relational database management system (RDBMS); using an RDBMS, you can manage groups of data (tables) and then set rules (relationships) between tables.
Good database design begins with grouping data into the correct tables= Normalization
Join lines enable you to create a relationship between two tables using a common field. When relationships are established, three options are available to further dictate how Access will manage the relationship: Enforce referential integrity, Cascade update related fields, and Cascade delete related records.
Using the enforce referential integrity option will help keep invalid data out of your database. Examples of invalid data include (1) entering an order for a customer that does not exist, (2) tagging a new product with a nonexistent category, and (3) entering a person’s address with an invalid state/province abbreviation.
Using the Relationships Window
The most common method of connecting two tables is to connect the primary key from one table to the foreign key of another. A foreign key is a field in one table that is also the primary key of another
table.
To create a relationship between two tables, follow these guidelines:
1. Click Relationships in the Relationships group on the Database Tools tab.
2. Add the two tables that you want to join together to the Relationships window.
3. Drag the common field (e.g., SupplierID) from the primary table (e.g., Suppliers) onto
the common field (e.g., SupplierID) of the related table (e.g., Products).
4. The data types of the common fields must be the same.
5. Check the Enforce Referential Integrity check box.
6. Close the Relationships window.
Enforce Referential Integrity
Enforce referential integrity is one of the three options you can select when setting a table relationship. When enforce referential integrity is checked, Access ensures that data cannot be entered into a related table unless it first exists in the primary table.
Referential integrity also prohibits users from deleting a record in one table if it has records in related tables
Create Sample Data
When learning database skills, starting with a smaller set of sample data prior to entering all company records can be helpful. The same design principles apply regardless of the number of records. A small amount of data gives you the ability to check the tables and quickly see if your results are correct. Even though the data amounts are small, as you test the database tables and relationships, the results will prove useful as you work with larger data sets.
Understanding Relational Power
Table connections enable you to query (ask) the database for information stored in multiple tables.
The design of a relational database enables us to extract information from multiple tables in a single query or report.
RELATIONAL DATABASES AND QUERIES
Table Design, Properties, Views, and Wizards
Good database design begins with the tables. Tables provide the framework for all of the activities you perform in a database. If the framework is poorly designed, the rest of the database will be poorly designed as well
Designing Data
A table is a storage location in a database that holds related information. A table consists of records, and each record is made up of a number of fields.
Looking at the output will help determine the tables and fields needed to produce that output. Think of the specific fields you need in each table; list the fields under the correct table and assign each field a data type (such as text, number, or date) as well as its size (length) or format. The order of the fields within the table and the specific field names are not significant. What is important is that the tables contain all necessary fields so that the system can produce the required information
After the tables have been identified, add the necessary fields using these six guidelines:
1. Include the necessary data.
2. Design for now and the future.
3. Store data in its smallest parts.
4. Add calculated fields to a table.
5. Design to accommodate date arithmetic.
6. Link tables using common fields.
Include the Necessary Data
If you discover a missing field, you can insert a row anywhere in the appropriate table and add the missing field.
Design for Now and the Future
When designing a database, try to anticipate the future needs of the system, and then build in the flexibility to satisfy those demands. For example, when you add a text field, make sure that the number of characters allocated is sufficient to accommodate future expansion. On the other hand, if you include all the possible fields that anyone might ever need, you could drive up the cost of the database.
Each additional field can increase the cost of the database, since it will require additional employee time to enter and maintain the data. The additional fields will also require more storage space, which you will need to calculate, especially when working with larger databases. Good database design must balance the data collection needs of the company with the cost associated with collection and storage.
Store Data in Its Smallest Parts
You might think it easier to use a single field consisting of both the first and last name, but that approach is too limiting. The first problem in this approach is the lack of flexibility. A second difficulty is that the list of customers cannot be easily displayed in alphabetical order by last name because the last name begins in the middle of the field. The names could easily be alphabetized by first name because the first name is at the beginning of the field. However, the most common way to sort names is by the last name, which can be done more efficiently if the last name is stored as a separate field.
Add Calculated Fields to a Table
A calculated field produces a value from an expression or function that references one or
more existing fields.
Storing calculated data in a table enables you to add the data easily to queries, forms, and reports without the trouble of an additional calculation. Storing calculated data in a table may increase the size of the database slightly, but the benefits may outweigh this drawback.


Design to Accommodate Date Arithmetic
A person’s age is another example of a calculated field using date arithmetic—date of birth is subtracted from today’s date and the results are divided by 365. It might seem easier to store a person’s age rather than the birth date to avoid the calculation. But that would be a mistake because age changes over time and would need to be updated each time age changes.
Storing the date of birth is much better since the data remains constant (unchanging value) 
You can use date arithmetic to subtract one date from another to find out the number of days, months, or years that have lapsed between them. You can also add or subtract a constant from a date.
Link Tables Using Common Fields
The tables will be joined in relationships using common fields. Draw a line between common fields to indicate the joins
Avoid data redundancy, which is the unnecessary storing of duplicate data in two or more tables. You should avoid duplicate information in multiple tables in a database, because errors may result
Creating Tables
You can create a table by creating the fields in Design view (as shown in Figure 3) or by entering table data into a new row in Datasheet view, or you can import data from another database or application such as Excel. Regardless of how a table is first created, you can always modify it later to include a new field or to change an existing field.
Each field in a table has a field name to identify the data that it holds. 
The field name should be descriptive of the data and can be up to 64 characters in length, including letters, numbers, and spaces. 
Database developers use CamelCase notation for field names, object names, and file names. Instead of spaces in multi-word field names, use uppercase letters to distinguish the first letter of each new word, for example, ProductCost or LastName. It is best to avoid spaces in field names, since spaces can cause problems when creating the other objects based on tables—such as queries, forms, and reports.
Every field also has a data type that determines the type of data that can be entered and the operations that can be performed on that data. Access recognizes 10 data types.
Establish a Primary Key
The primary key is the field (or combination of fields) that uniquely identifies each record in a table. Access does not require that each table have a primary key. However, good database design usually includes a primary key in each table. You should select unique and infrequently changing data for the primary key. For example, a complete address (street, city, province, and postal code) may be unique but would not make a good primary key because it is subject to change when someone moves.
When no primary key occurs naturally, you can create a primary key field with the AutoNumber data type. The AutoNumber data type is a number that automatically increments each time a record is added.
Explore Foreign Key
A foreign key, as defined earlier, is a field in one table that is also the primary key of another table
Use Table Views
Users can work in Datasheet view to add, edit, and delete records. Displays data in a grid format—rows represent records, and columns represent fields. Datasheet view indicates the current record using a gold border; you can select a record by clicking the record selector on the left side of each record
Design view is used to create and modify the table structure by adding and editing fields and by setting the field properties


.
Work with Field Properties
A field’s data type determines the type of data that can be entered and the operations that can be performed on that data. A field property is a characteristic of a field that determines how the field looks and behaves.
A field with a text data type can store either text or numerical characters. A text field can hold up to 255 characters
A field with a number data type can store only numerical data. 
Set the Format field property to Integer to display the field contents as integers from –32768 to 32768. Set the Format field property to Long Integer for larger values.
You can use the caption property to create a more readable label that appears in the top row in Datasheet view and in forms and reports. For example, a field named ProductCostPerUnit could have the caption Per Unit Product Cost. The caption displays at the top of a table or query column in Datasheet view and when the field is used in a report or form. You must use the actual field name, ProductCostPerUnit, in any calculation.
Set the validation rule property to restrict data entry in a field to ensure the correct type of data is entered or that the data does not violate other enforced properties. The validation rule checks the data entered when the user exits the field. If the data entered violates the validation rule, an error message appears and prevents the invalid data from being entered into the field.
Multiple Table Databases
Understanding Table Relationships
Relationships between tables are set in the Relationships window. In this window, join lines are created to establish relationships between two tables. As discussed earlier, the benefit of a relationship is to efficiently combine data from related tables for the purpose of creating
queries, forms, and reports. 
The primary key of a table plays a significant role when setting relationships. You cannot join two tables unless a primary key has been set in the primary table
The other side of the relationship join line is most often the foreign key of the related table. A foreign key is a field in one table that is also the primary key of another table.
Relationships between tables will almost always be set using primary and foreign keys.
Establish Referential Integrity
When referential integrity is enforced, you cannot enter a foreign key value in a related table unless the primary key value exists in the primary table
Set Cascade Options
When you create a relationship in Access and click the Enforce Referential Integrity checkbox,
Access gives you two additional options—Cascade Update Related Fields and Cascade Delete Related Records. Check the Cascade Update Related Fields option so that when the primary key is modified in a primary table, Access will automatically update all foreign key values in a related table
Check the Cascade Delete Related Records option so that when the primary key is deleted in a primary table, Access will automatically delete all records in related tables that reference the primary key
Retrieve Data Quickly with Indexing
When you set the primary key in Access, the indexed property is automatically set to Yes (No Duplicates). The Indexed property setting enables quick sorting in primary key order and quick retrieval based on the primary key. For non-primary key fields, it may be beneficial to set the Indexed property to Yes
indexed fields are usually foreign keys and are numeric.
Sharing Data with Excel
Wizard enables you to get data from excel and to import data to excel
Establishing Table Relationships
Store like data items together in the same table
One-to-Many This relationship is between a primary key in the first table and a foreign key in the second table.
The first table must have only one occurrence of each value. For example, each customer must have a unique identification number in the Customers table, or each employee must have a unique EmployeeID in the Employee table. The foreign key field in the second table may have repeating values. For example, one customer may have many different account numbers, or one employee can perform many services. Is established when the primary key value in the primary table can match many of the foreign key values in the related table
One-to-One Two different tables use the same primary key. Exactly one record exists in the second table for each record in the first table. Sometimes security reasons require a table to be split into two related tables. For example, anyone in the company can look in the Employee table and find the employee’s office number, department assignment, or telephone extension. However, only a few people need to have access to the employee’s salary, Social Insurance Number, performance review, or marital status. Both tables use the same unique identifier to identify each employee.
Many-to-Many This is an artificially constructed relationship giving many matching records in each direction between tables. It requires construction of a third table called a junction table. For example, a database might
have a table for employees and one for projects. Several employees might be assigned to one project, but one employee might also be assigned to many different projects. When Access connects to databases using Oracle or other software, you find this relationship type.
Establish a One-to-Many Relationship
Establish the relationships by dragging the common field name from the primary table onto the common field name in the related table.
Single-Table Queries
A query enables you to ask questions about the data stored in a database.
You use the Query Design view to create queries; the Design view is divided into two parts—the top portion displays the tables, and the bottom portion (known as the query design grid) displays the fields and the criteria. Using the Query Design view, you select only the fields you want arranged in the order that you want them. The design grid also enables you to sort the records based on one or
more fields.You can also create calculated fields to display data based on expressions that use the fields in the underlying table. For example, you could calculate the monthly interest earned on each bank account
Creating a Single-Table Query
Simple Query Wizard provides dialog boxes to guide you through the query design process.
The wizard is helpful for users who are not experienced with Access or with queries. 
More advanced users will usually use the Query Design tool to create queries. This method provides the most flexibility when creating queries (but without the prompting of the wizard) You can add criteria to a query while in the Query Design view, as compared to the wizard where you cannot add criteria while the wizard is running. 
After the query is created, you can switch to Design view and add criteria manually.
After you design a query (using either method), you can display the results of the query by switching to Datasheet view. A query’s datasheet looks and acts like a table’s datasheet, except that it is usually a subset of the records found in the entire table.
The subset only shows the records that match the criteria that were added in the query design. The subset will usually contain different sorting of the records than the sorting in the underlying table.
Datasheet view allows you to enter a new record, modify an existing record, or delete a record. Any changes made in Datasheet view are reflected in the underlying table.
Create a Single-Table Select Query
By default, when you create a query, you create a select query, which is the most common type of query. A select query displays only the records that match the criteria entered in Design view. A select query does not change the data. Other types of queries, known as action queries, can update, append, or delete records when they are run. Examples include Update Query, Append Query, and Make Table Query.
Use Query Design View
The Query Design view consists of two parts. The top portion contains tables with their respective field names. If a query contains more than one table, the join lines between tables will be displayed as they were created in the Relationships window. The bottom portion (known as the query design grid) contains columns and rows. Each field in the query has its own column and contains multiple rows. The rows permit you to control the query results.
• The Field row in the Query Design view displays the field name.
• The Table row in the Query Design view displays the data source.
• The Sort row in the Query Design view enables you to sort in ascending or descending order.
• The Show row in the Query Design view controls whether the field will be displayed in the query results.
• The Criteria row in the Query Design view is used to set the rules that determine which records will be selected, such as customers with accounts greater than $5,000.
You will toggle between Design view and Datasheet view when you create queries. 
Use Design view to specify the criteria; you can use the results to answer a question or to make a decision about the organization.
Use Datasheet view to see the results of your query. 
Each time you need to fine-tune the query, switch back to Design view, make a change, and then test the results in Datasheet view. After you are satisfied with the query results, you may want to save the query so it can become a permanent part of the database and can be used later.
Specifying Criteria for Different Data Types
The field data type determines which delimiters are required for the criterion of a field. A delimiter is a special character that surrounds the criterion’s value
You need to enter criteria for a text field enclosed in quotation marks.
Access accepts values for text fields in the design grid with or without quotation marks; if you enter Campus,Access will add the quotes for you.You enter the criteria for a numeric field, currency, or AutoNumber as plain digits (no quotations). You can enter numeric criteria with or without a decimal point and with or without a minus sign. (Commas and dollar signs are not allowed.) When the criterion is in a date field, you enclose the criterion in pound signs, such as #10/14/2012#. Access accepts a date with or without the pound signs; if you enter 1/1/2012 without the pound signs, Access will add the pound signs when you move to another column in the design grid. The date value should be in the mm/dd/yyyy format. You enter criteria for a Yes/No field as Yes or No
Use Wildcards
Suppose you want to search for the last name of a customer but you are not sure how to spell the name; however, you know that his name starts with the letters Sm. You can specify the criteria in the LastName field as Sm*, which would display all last names that begin with Sm. The asterisk is known as a wildcard.
Wildcards are special characters that can represent one or more characters in a text value. You enter wildcard characters in the Criteria row of a query.
A question mark is a wildcard that stands for a single character in the same position as the question mark; for example, H?ll will return Hall, Hill, and Hull. 
The asterisk wildcard stands for any number of characters in the same position as the asterisk; for example, S*nd will return Sand, Stand, and StoryLand.
A comparison operator, such as equal (=), not equal (<>), greater than (>), less than (<), greater than or equal to (>=), and less than or equal to (<=), can be used in the criteria of a query. Comparison operators enable you to limit the query results to only those records that meet the criteria
#2/2/2012# For a field with a Date/Time data type, such as a ShippedDate field, orders shipped on February 2, 2012.
“Harry” For a Text field, find the name Harry.
Date( ) For an OrderDate field, orders for today’s date.
Between #1/1/2012# and #3/31/2012# For a specified interval between a start and end date, including the start and end dates
Work with Null and Zero-Length Strings
Are there missing phone numbers or addresses for some of your customers? Ask for customers with a missing PhoneNumber. The term that Access uses for a blank field is null.
Understand Query Sort Order
The query sort order determines the order of records in a query’s Datasheet view. You can change the order of records by specifying the sort order in the Design view. The sort order is determined from left to right.
Establish AND, OR, and NOT Criteria
When the criteria are in the same row of the query design grid, Access interprets the instructions using the AND logical operator. This means that the query results will display only records that match all criteria. 
When the criteria are positioned in different rows of the design grid, Access interprets the instructions using the OR logical operator. The query results will display records that match any of the specified criteria. 
The NOT logical operator returns all records except the specified criteria. For example, “Not
Eastern” would return all accounts except those opened at the Eastern branch.
Copying and Running a Query
After you create a query, you may want to create a duplicate copy to use as the basis for creating a similar query. Duplicating a query saves time when you need the same tables and fields but with slightly different criteria.
Several ways exist to run a query. One method is to locate the query in the Navigation Pane, and then double-click it. A similar method is to select the query, and then press Enter. Another way is to click Run in the Results group, when you are in Design view.
Copy a Query
Sometimes you need a series of queries where each query is similar to the first. For example, you need “Sales for This Month” in Victoria, in Edmonton, and in Regina. In cases like this, you create a query for the first city and then save the query. Click Save As to save a copy of the query and name it for the second city. Change the criteria to match the second city. Repeat the process for the third city.
Run a Query
The Run command (the red exclamation point) is used to produce the query results.
Multi-Table Queries
Multi-table queries contain two or more tables. They enable you to take advantage of the relationships that have been set in your database. When you need to extract information from a database with a query, most times you will need multiple tables to provide the answers you need.
One table may contain the core information that you need. Another table may contain the related data that makes the query relevant to the users.
Creating a Multi-Table Query
Related tables are tables that are joined in a relationship using a common field.As a rule, related tables should already be established when you create a multi-table query
Add Additional Tables to a Query
You can modify a saved query using Design view for the query
Get Answers Using a Multi-Table Query
You can get key information from your database using a multi-table query.
Modifying a Multi-Table Query
Add tables using the Show Table dialog box; remove tables by clicking the unwanted table and then pressing Delete. Add fields by double-clicking the field you want; remove fields by clicking the column selector and then pressing Delete. Join lines between related tables should appear automatically in a query if the relationships were previously established
Fix a Common Problem in a Multi-Table Query
Access does not know how to interpret the unrelated tables and shows all possible query results. To fix this problem, you can create join lines using the existing tables if the tables facilitate this. Or you can add an additional table that will provide a join between all three tables. In the Branch query, you can add the Accounts table, which will facilitate a join between the two existing tables, Customers and Branch. As soon as the third table is added to the query design, the join lines appear automatically
Add a Join Line in a Multi-Table Query
When queries are created with the new tables, join lines will not be established. When this happens, you can create temporary join lines in the query design. These join lines will provide a temporary relationship between two tables and enable Access to interpret the query properly. The process of creating a multi-table query works the same as creating a single-table query (covered previously in this chapter). In the Query Design view, you will add fields to the bottom portion (the query design grid), set the sorting, decide whether to show the fields, and add criteria as needed
Calculations, Expressions, and Functions
Access allows calculated fields to be added to tables
Many Access developers prefer to create calculated fields in queries. Queries with calculated fields can then become the data source (or record source) for forms and reports. Calculated fields on a form cannot be edited the same way fields from a table can be edited. Calculated fields can only be displayed on a form. For example, if you store information about credit cards in a table, you would enter the bank (Scotiabank), the credit card type (Visa), and the interest rate (9%). You would not enter the current amount due. That amount would be calculated and displayed on the form. You will recognize this restriction later when you create a form containing calculated fields.
Understanding the Order of Operations
The order of operations determines the sequence by which operations are calculated in an expression.
· Parentheses ( )
• Exponentiation ˆ
• Multiplication *
• Division /
• Addition +
• Subtraction –

Creating a Calculated Field in a Query
When creating a query, in addition to using fields from tables, you may also need to create a calculation based on the fields from one or more tables.
You create calculated fields in the Design view of a query. A formula used to calculate new fields from the values in existing fields is known as an expression. An expression can consist of a number of different elements to produce the desired output. The elements used in an expression may include the following:
• Identifiers (the names of fields, controls, or properties)
• Arithmetic operators (e.g., * , / , + , or –)
• Functions (built-in functions like Date() or IIf())
• Constants (numbers such as 30 or .5)
You can use calculations to create a new value based on an existing field, verify data entered, set grouping levels in reports, or help set query criteria.
Build Expressions with Correct Syntax
Expressions are entered in the first row of the query design grid. You must follow the correct syntax—the set of rules that Access follows when evaluating expressions. You can create expressions to perform calculations using field names, constants, and functions. If you use a
field name, such as Balance, in an expression, you must spell the field name correctly or Access will display an error.You should assign descriptive field names to the calculated fields. Access ignores spaces in calculations. An example of an expression with correct syntax is: 
MonthlyInterest: [Balance]*.035 / 12
Verify Calculated Results
Manually or using excel
Save a Query Containing Calculated Fields
Saving a query only saves the design of the query; saving does not save the data displayed in Datasheet view.While viewing the results of a query in Datasheet view, you can edit the data (and consequently update the data in the underlying table) providing the query is updatable. Calculated fields are the exception to this rule—calculated fields cannot be updated in Datasheet view. However, when the components of a calculated field are updated, the calculated field value will update automatically. You can use a calculated field as input for other calculated fields. For example, calculate a 10% discount on an item (Calculation #1) and then calculate the sales tax on the discount price (Calculation #2).
Expression Builder, Functions, and Date Arithmetic
Use the Expression Builder tool to help you create more complicated expressions. When you create an expression in the field cell, you must increase the column width to see the entire expression. The Expression Builder’s size enables you to easily see complex formulas and functions in their entirety.
Creating Expressions with the Expression Builder
The Expression Builder helps you create expressions by supplying you with the fields, operators, and functions you need to create them.When you use the expression builder to help you create expressions, you can eliminate spelling errors in field names. Another advantage is with functions; functions require specific arguments in a specific order.When you insert a function using the Expression Builder, the builder gives you placeholders that tell you where each argument belongs.
You can also use the Expression Builder when working with controls in forms and reports.
You can also use the Expression Builder to select a built-in function—for example, to calculate a payment on a loan
Launch the Expression Builder
Open a query in Design view and verify the Design tab is selected on the Ribbon. Click Builder in the Query Setup group and the Expression Builder launches
Create an expression with the expression box



Create an Expression
The left column of the Expression Builder dialog box contains Expression Elements, which include the built-in functions, the tables and other objects from the current database, and common expressions. Select an item in this column; the middle column will show the list of options.
You can create an expression by manually typing text in the expression box or by doubleclicking the elements from the bottom section in the Expression Builder dialog box
Calculated fields are relatively simple to create and most Access developers can create them without the Expression Builder. The main reason to use the builder for a calculated field is to eliminate spelling errors in field names. Using functions in Access almost always requires the Expression Builder since the syntax of functions can be difficult to remember.
Using Built-In Functions in Access
A function produces a result based on inputs known as arguments. An argument is a variable or constant that is needed to produce the output for a function. Once you identify what you need a function to do, you can check the Built-In Functions in the Expression Builder to see if the function exists. If it does, add the function to the expression box and replace the <<placeholder text>> with the argument values.
The Pmt function calculates the monthly loan payment given the interest rate (monthly), term of  the loan (in months), and the original value of the loan (the principal). The first argument is the interest rate per period. Interest rates are usually stated as annual rates, so you will need to convert them to monthly rates by dividing by 12. The second argument is the number of periods. Because loan terms are usually stated in years, you will need to convert the period to months by multiplying by 12. The next argument is the present value— or principal—of the loan. It tells you how much each customer has borrowed. The last two arguments, future value and type (both optional), are usually 0 or blank. The future value shows the amount the borrower will owe after the last payment has been made. The type argument tells Access whether the payment is made at the beginning or the end of the period.
monthly payment
$12,500 loan, at a 6.0% interest rate, with a four-year payback term
Function: Pmt(rate, num_periods, present value, future value, type)
Example: Pmt(0.06/12, 4*12, 12500)
Create Conditional Output with the IIf Function
IIf function, evaluates an expression and displays one value when the expression is true and another value when the expression is false. The expression must evaluate as true or false only. For example, balance >= 10000 or City = “Calgary” are valid expressions. DateListed + 90 is not a valid expression for the IIf function since this expression will yield a date. Access evaluates the expression, determines whether it is true or false, then displays one value if the expression is true and another value if the expression is false.
If accounts with balances of $10,000 or more earn 3.5% interest, whereas accounts with balances below $10,000 earn only 1.5% interest, the following IIf function could be created:
Example: IIf (Balance >=10000, .035, .015)
Function: IIf (expression, truepart, falsepart)
When you finish the expression, click OK to close the Expression Builder dialog box. 
If you are working in a query, nothing will happen until you run the query. Your newly calculated
field displays in the Datasheet view of the query. 
If you are working in a form, switch to Form view to see the results of your expression. 
If you are working in a report, click Print Preview to see the results
Performing Date Arithmetic
Date formatting affects the date’s display without changing the actual underlying value in the table. All dates and times in Access are stored as the number of days that have elapsed since December 31, 1899.
Dates are stored by Access as sequential numbers
Using date arithmetic you can create expressions to calculate lapsed time, such as a person’s age based on birth date or the number of days past due an invoice is based on the invoice date.
Identify Partial Dates with the DatePart Function
Using a date function, you can isolate a portion of the date that is of interest to you
If your company increases the number of weeks of annual vacation from two weeks to three weeks after an employee has worked for five or more years, then the only part of the date of interest is the time lapsed in years. Access has a function, the DatePart function, to facilitate this.
Example: DatePart(“yyyy”, [Employees]![HireDate])
Function: DatePart(interval, date), firstdayofweek, firstweekofyear
Useful date functions are:
• Date—Inserts the current date into an expression.
• DatePart—Evaluates a date and returns only the portion of the date that is
designated.
• DateDiff—Measures the amount of time elapsed between two dates. This is most
often today’s date as determined by the date function and a date stored in a field. For
example, you might calculate the number of days a payment is past due by comparing
today’s date with the payment DueDate.
Aggregate Functions
Aggregate functions perform calculations on an entire column of data and return a single value.Aggregate functions—such as Sum,Average, and Minimum—are used when you need to evaluate a group of record values rather than the individual records in a table or query. Access refers to aggregate functions as Totals. In the Datasheet view of a query or table, click Totals in the Records group on the Home tab to add a Total row to the bottom of the datasheet. Each column can
have its own aggregate function. Numeric fields are eligible for all of the functions, whereas text fields are only eligible for the count function.
When you create a query in Design view, click Totals in the Show/Hide group to change it to a totals query. The Total row now appears and you can select from the list of aggregate functions (e.g., Sum, Avg,Min). 
The Datasheet view of a query or table displays individual records; users can edit these records, enter a new record, or delete a record in Datasheet view. However, when you work within a totals query in Datasheet view, no updates are allowed. A user cannot add, update, or delete records that have been totalled.
Standard Deviation: Measures how widely values are dispersed from an average value.
Variance: Measures the statistical variance of all values in the column.
Adding Aggregate Functions to Datasheets and Queries
Aggregate functions are most commonly used in tables, queries, and reports. Occasionally, aggregate functions are also added to the form footer section of forms. Aggregate data helps users evaluate the values in a single record as compared to the average of all the records.
Access provides two methods of adding aggregate functions to a query—a Total row displayed as the last row in the Datasheet view of a table or query and a totals query created in query Design view.
The first method enables you to add a Total row to the Datasheet view. This method is quick and easy and has the advantage of showing the total information while still showing the individual records. Adding a Total row to a query or table can be accomplished by most users (even those who are not familiar with designing a query).
The second method requires you to add a Total row in the Query Design view. This method has the advantage of enabling you to group your data by categories. For example, you can use the Count function to show the number of houses sold in each county in each subdivision. You could also use the Average function to show the average sale price for houses sold in each subdivision.
Access also permits aggregates in reports. The Report Wizard gives users a choice to show all detail records or summary-only statistics. Select summary only to see aggregate data.
Create a Totals Query
A totals query contains an additional row in the query design grid and is used to display only aggregate data when the query is run. 
This is in contrast to using the Total row in a datasheet which shows both the detail records and the summary (as described in the previous section).
The first column of a totals query will usually be a grouping field; the Total row will contain the Group function. The second and subsequent columns will usually contain the Count, Sum, or Avg function. Problems can arise when too many columns are included in a totals query; a typical totals query contains only two to five columns.
Form Basics
A form is a database object that is used to add data into or edit data in a table. Most Access database applications use forms rather than tables for data entry and for looking up information.
Three main reasons exist for using forms rather than tables for adding, updating, and deleting data. They are:
· You are less likely to edit the wrong record by mistake.
· You can create a form that shows data from more than one table simultaneously.
· You can create Access forms to match paper forms.
Creating Forms Using the Form Tools
Access provides 16 different tools for creating forms. The Forms group, located on the Create tab, contains four of the most common form tools (Form, Form Design, Blank Form, and Form Wizard), a list of Navigation forms, and a list of More Forms, as shown in Figure 1. Navigation forms provides a list of six templates to create a user interface for a database; the More Forms command lists six additional form tools (Multiple Items, Datasheet, Split Form, and more). Select a table or query, click one of the tools, and Access will create an automatic form using the selected table or query. The most common of these tools, the Form tool, is used to create data entry forms for customers, employees, products, and other primary tables A primary table has a single field as its primary key and represents the “one” side of a one-tomany relationship.
A form should simplify data entry
The Form tool is used to create data entry forms for customers, employees, products, and other primary tables.
Identify a Record Source
Before you create a form, you must identify the record source. A record source is the table or query that supplies the records for a form or report. Use a table if you want to include all the records from a single table. Use a query if you need to filter the records in a table, or if you need to combine records from two or more related tables.
Sketch the form 
After sketching the form, you will have a better idea of which form tool to use to create the form. After the form is created, use the sketch to determine which fields are required and what the order of fields should be
Use the Form Tool
A stacked layout form displays fields in a vertical column, and displays one record at a time. Multiple Items and Datasheet forms, in contrast to stacked layout forms, are examples of tabular layout forms.
A tabular layout form displays records horizontally, with label controls across the top and the data values in rows under the labels. When a new form is created using the Form tool, Access opens the form in Layout view ready for customizing. 
You can generate forms for your database using the Form tool, and then use Layout view to modify the design of a form.
Work with a Subform
When you use the Form tool to create a form, Access will analyze the table relationships you created in the database and automatically add a subform to the main form. A subform displays records with foreign key values that match the primary key value in the main form.
At times, you may want the subform as part of your form; other times, you may want to remove it. To remove a subform control from a form, switch to Design view, click the subform control, and then press Delete
Create a Split Form
A split form combines two views of the same record source—one section is displayed in a stacked layout and the other section is displayed in a tabular layout. By default, the form view is positioned on the top and the datasheet view is displayed on the bottom; however, the orientation can be changed from horizontal to vertical in Layout view. If you select a record in the top half of the form, the same record will be selected in the bottom half of the form, and vice versa.
The splitter bar divides the form into two halves. Users can adjust the splitter bar up or down unless the form designer disables this option.
Create a Multiple Items Form
A Multiple Items form displays multiple records in a tabular layout similar to a table’s Datasheet view. However, a Multiple Items form gives you more customization options than a datasheet, such as the ability to add graphical elements, buttons, and other controls.
Create a Datasheet Form
A Datasheet form is a replica of a table or query’s Datasheet view except that it still retains some of the form properties.
A datasheet form, like all Access forms, can be customized to add additional functionality using Visual Basic for Applications (VBA). VBA is Microsoft’s programming language that is built into all of the Office products. VBA enables an advanced Access user to customize forms and reports. Although a field’s data type and field properties help prevent invalid data from being added to a table, you can use VBA to enforce more complex data entry rules.
Database designers can also use the Datasheet form to display data in a table-like format, but change the form properties to not allow a record to be deleted. This would protect the data from accidental damage while still providing the users with the familiar Datasheet view
Create Forms Using the Other Form Tools
The Form Design tool and the Blank Form tools can be used to create a form manually
The Navigation option in the Forms group enables you to create user interface forms that have the look and feel of a Web-based form, and enable users to open and close the objects of a database. These forms are also useful for setting up an Access database on the Internet.
PivotTables and PivotCharts can also be converted to forms by selecting PivotChart or PivotTable in the More Forms option in the Forms group. After you create a PivotTable form or a PivotChart form, use the Layout view and Design view to customize the form. The Modal Dialog Form tool can be used to create a dialog box. This feature is useful when you need to gather information from the user before working with another object. Dialog boxes are common in all Microsoft Office applications; creating a custom dialog box in Access can be useful when you need to collect information from the user
Modifying a Form
Add a Field to a Form
To add a field to a form with a stacked layout, open the form in Layout view. Click Add Existing Fields in the Tools group on the Design tab to reveal the available fields from the form’s record source. Drag the new field to the precise location on the form, using the orange line as a guide for the position of the new field. The other fields will automatically adjust to make room for the new field.
To add a field to a form with a tabular layout, follow the same steps for adding a field to a stacked layout form. The only difference is the orange line will appear vertically to help determine the insertion point of the new field.
Work with a Form Layout Control
Form layout controls can help you create and modify forms. A layout control provides guides to help keep controls aligned horizontally and vertically, and give your form a uniform appearance. However, there are times when a layout control is too restrictive and will keep you from positioning controls where you want them. In this case, you can remove the layout control and position the controls manually on the grid To remove a form layout control, switch to Design view, and then click anywhere inside the control you want to remove. On the Arrange tab, click Select Layout in the Rows & Columns group. (You can also click the Layout Selector, the small square with a cross inside, to select the layout.) Click Remove Layout in the Table group and the layout control is gone.
All of the other controls are still on the form, but the rectangle binding them together is gone. You can add a layout control to a form by first selecting all the controls you want to keep together. Then, click Stacked or Tabular in the Table group and the layout control appears
Adjust Column Widths in a Form
When column widths are adjusted in a form with a stacked layout, all columns will increase and decrease together. Therefore, it is best to make sure that field columns are wide enough to accommodate the widest value in the table.
Change the Sorting in a Form
To modify the sort order of a form, open the form in Form view, and then select the field you want to use for sorting.Next, click Ascending in the Sort & Filter group on the Home tab and the records will immediately be reordered based on the selected field.
You can also modify the sort order of a form by modifying the underlying query’s sort order. The method enables you to create a more advanced sort order, based on multiple fields.
You can also remove sorting in a form
Form Sections, Views, and Controls
As you work with the form tools to create and modify forms, you will often need to switch between the three form views in Access—Layout view, Form view, and Design view.Most of your design work will be done in Layout view; occasionally, you will switch to Design view to add a more advanced feature, such as a calculated field. Users of the form will only work in Form view
Identifying Form Sections
Access forms, by default, are divided into three sections that can be viewed when you display
a form in Design view. Each section can be collapsed or expanded as needed, but only in
Design view.
Identify the Default Form Sections
Each form by default contains three main sections—Form Header, Detail, and Form Footer. These sections can vary depending on what type of form you create. Stacked layout forms will have different requirements than a tabular layout form. Form designers also have the option of removing certain sections from a form. Two additional sections—Page Header and Page Footer—are optional and can be added to a form as needed. These sections are visible in Design view and also during Print Preview and printing; however, page headers and footers are not visible in Form view or Layout view.
The Form Header section displays at the top of each form. This section will usually contain the form title, a logo or other graphic, and the current date and time. Column headings (labels) will also be located in this section for Multiple Item forms.
The Detail section displays the records in the form’s record source. Stacked forms will display one label and one text box for each field placed in the Detail section.Navigation controls enable the user to advance to the next, last, previous, and first record. Multiple Item forms will display multiple records (text boxes) in the Detail section, as many as can fit onto one screen.
The Form Footer section displays at the bottom of the form. The Form Footer is commonly used to add totals for field values.
Modify the Default Form Sections
To expand or collapse the space between sections, move your mouse over the bottom bar, and when the mouse pointer changes to a double-headed arrow, click and drag to expand or collapse the section. If you expand or collapse the space allotment for one section, the overall height of the form will be affected.
Revising Forms Using Form Views
Access provides different views for a form, similar to the different views in tables and queries.
Tables and queries have Design view and Datasheet view. Most forms have Layout view, Form view, and Design view. A Datasheet form has one additional view, the Datasheet view, but it does not have the Form view.
You can switch between form views
Edit Data in Form View
Use Form view to add, edit, and delete data in a form; the layout and design of the form cannot be changed in this view.
Alter a Form in Layout View
Use Layout view to alter the form design while still viewing the data.You use Layout view to add or delete fields in a form, modify field properties, change the column widths, and enhance a form by adding a colour scheme or styling.While you are working in Layout view, you can see the data as it would appear in Form view, but you cannot edit the data in Layout view. Seeing the data in Layout Perform Advanced Changes to a Form in Design View
Use Design view to perform advanced changes to a form’s design. It provides you the most advanced method of editing an Access form. You can perform many of the same tasks in Design view as you can in Layout view—add and delete fields, change the field order, adjust field widths, modify labels, and customize form elements. But certain tasks cannot be done in Layout view, and Access displays a message telling you to use Design view. For example, changes to the form sections can only be made in Design view. After you finish making changes in Design view, it is best to switch to Form view to examine the results. view makes it easier to size controls, for example, to ensure the data is visible
Identifying Control Types in Forms
If you examine the fields on the form in Figure 16, notice that each field has a label on the left and a text box on the right. The text box control displays the data found in a form’s record source (the Customers table in this example) and the label control is a literal word or phrase to describe the data. The position of the label and the text box can be interchanged; however in most cases, the label is positioned to the left of the text box in a stacked layout. Although the term text box might imply text only, a text box can also display numeric data, currency, and dates.
Work with Controls
Label and Text Box objects are known as controls
Controls can be categorized as bound, unbound, or calculated. 
A bound control is a text box that is connected to a field in a table or query. These controls display different data each time you switch to a new record.
An unbound control is a label or other decorative design element, and is not connected to a source of data. These controls usually describe and decorate the data rather than display the data, and remain the same each time you switch to a new record. Unbound controls include labels, lines, borders, and images
A calculated control contains an expression that generates a calculated result when displayed in Form view. The expression can contain field names from the form’s record source, constants, and functions
Most forms include an unbound control (label) to describe each bound control (text box) on the form.
Add a Calculated Control to a Form
Users must manually calculate an employee’s years of service using the HireDate field at the bottom of the form. Based on your knowledge of date arithmetic, you could calculate each employee’s years of service using the expression:
= (Date( ) – HireDate) / 365
To add this expression to the form, you add a calculated field using a text box.
Add Styling to a Form
Modifying the font size of labels, changing the font colour of labels, and adding a background colour can enhance a form and also make it more usable. It is best to choose a familiar font family, such as Arial or Calibri, for both the form label controls and the text box controls. Apply bold to the labels in order to help the user distinguish labels from the text boxes. You should also consider left-aligning the labels to themselves and left-aligning the text box controls to themselves
Report Basics
A report is a printed document that displays information from a database in a format that provides meaningful information to its readers. Although you can print information from tables, queries, and forms, information printed from these database objects may not be in the best format.Most of the printed documents generated by Access will come from reports. Reports can be enhanced to help the reader understand and analyze the data.
Creating Reports Using Report Tools
Access provides five different report tools for creating reports. The report tools are found in the Reports group
The most common of the tools, the Report tool, is used to instantly create a tabular
report based on the table or query currently selected. 
The Blank Report tool is used to create a new blank report so that you can insert fields and controls manually and design the report.
The Report Design tool is used to create a new blank report in Design view. In Design view, you can make advanced design changes to reports, such as adding custom control types and
working with report sections. 
The Report Wizard tool will ask a series of questions and help you create a report based on your answers. The Labels tool is used to create a page of labels using one of the preformatted templates provided by Access. After you create a report using one of the report tools, you can perform modifications in Layout view or Design view.
Identify the Record Source
The first step in planning your report is to identify the record source. You may use one or more tables, queries, or a combination of tables and queries as the report’s record source.
When multiple tables are needed to create a report, you can add all the necessary tables into a single query, and then base the report on that query. (As stated earlier,multiple tables in a query must be related, as indicated with join lines. Tables with no join lines usually indicate an incorrect record source.)
Reports can also contain graphics as well as text and numeric data.
Sketch the Report
Design the report and indicate the record source (table names or query name), the title, the format of the report (stacked or tabular), the fields, and the order of fields. It would also be helpful to indicate the grouping and totals needed for the report.
Use the Report Tool
The easiest way to create a report is with the Report tool. Select a table or query in the Navigation Pane, then click Report in the Reports group on the Create tab, and Access creates a tabular layout report instantly. A tabular layout report displays data horizontally across the page in a landscape view
You can also create a stacked layout report in Access, although this type of report is less common. A stacked layout report displays fields in a vertical column. The number of records on one page depends on the number of fields in the record source. You can also force a new page at the start of each record.
Use the Report Wizard
You can also create a professional report with the Report Wizard. The Report Wizard asks you questions and then uses your answers to generate a report. The wizard uses six dialog boxes to
collect information about your report.
Start the Report Wizard
After thinking through the structure, the layout, and the record source, you are ready to launch the Report Wizard. First, select the report’s record source in the Navigation Pane, and then click Report Wizard in the Reports group on the Create tab. The wizard opens with the table or query (the record source) displayed in the first dialog box. Although you chose the record source before you started, the first dialog box enables you to select fields from additional tables or queries.
Add Grouping
Grouping lets you organize and summarize your data. You can also add totals (sum, count, average) at the end of a group. You can also add second and third level grouping. The order in which you select the groups dictates the order of display in the report 
Add Sorting and Summary Options
The summary information option will only appear if there is a numeric field in the selected fields. Click Summary Options if you want to add aggregate functions (e.g., sum, average, minimum, and maximum) and to specify whether you want to see detail records on the report or only the aggregate results.
For the sort options, specify which field you want to sort by first, then second, third, and fourth. For each field, choose ascending order or descending order.
Choose the Layout for the Report
The next dialog box will determine the report’s appearance. First, you select the layout from three options—Stepped, Block, or Outline. Clicking an option will give you a general preview in the preview area. You can also select the orientation for the report, either Portrait or Landscape Select an appropriate format for the report
Save and Name the Report- last step in the Report wizard
Use the Label Wizard
The Label Wizard enables you to easily create mailing labels, name tags, and other specialized tags. A mailing label is a specialized report that comes preformatted to coordinate with name-brand labels, such as Avery. You then use the Label Wizard to create a label that fits the 5660 template.
Modifying a Report
After a report is generated by one of the report tools, you will usually need to modify it. Similar to forms, the common changes to a report are add a field, remove a field, change the order of fields, change the width of a field, and modify the title. These changes, as well as adding a grouping level, are made in Layout view. Advanced changes, such as adding a calculated field or adding VBA code, can only be made in Design view.

Add a Field to a Report
Adding a field to a report with a tabular layout is similar to adding a field to a form with a tabular layout
The process of adding a field to a report with a stacked layout is the same as for a tabular layout. The only difference is the orange line will appear horizontally.
Delete a Field from a Report
To delete a field from the Detail section of a tabular report, first switch to the Layout view or Design view of the report
Work with a Report Layout Control
Whenever you use one of the report tools to create a new report, Access will add a layout control to help align the fields. Layout controls in reports work the same as layout controls in forms. As discussed earlier in this chapter, the layout control provides guides to help keep controls aligned horizontally and vertically, and give your report a uniform appearance. There are times when you may want to remove the layout control from a report in order to position the fields without aligning them to each other. If you want to remove the layout control from a report, switch to Design view, and then click anywhere inside the control you want to remove. On the Arrange tab, click Select Layout in the Rows & Columns group. Click Remove Layout in the Table group and the layout control is gone. All of the other controls are still on the report, but the rectangle binding them together is gone You can add a layout control to a report by first selecting all the controls you want to keep together. Then, click Stacked or Tabular in the Table group and the layout control appears.
Adjust Column Widths in a Report
You can adjust the width of each column in a tabular report individually so that each column is wide enough to accommodate the widest value.
You may also add a theme to a report
Sorting Records in a Report
When a report is created using the Report tool, the sort order of the records in the report is initially dependent on the sort order of the record source—similar to the way records are sorted in a form. The primary key of the record source usually dictates the sort order. However, a report has an additional feature for sorting.While in Layout view or Design view, click Group & Sort in the Grouping & Totals group on the Design tab. The Group, Sort, and Total pane now appears at the bottom of the report. This section enables you to set the sort order for the report and override the sorting in the report’s record source.
Change the Sorting in a Report
While working in the Layout view of a report, click Group & Sort to display the Group, Sort, and Total pane, as shown in Figure 38. To sort the records in a report by last name, click Add a sort and select LastName from the list. The report records will instantly sort by LastName in ascending order. Next, you can set a second sort by clicking Add a Sort again.
Report Sections, Views, and Controls
As you work with the report tools to create and modify reports, you will find the need to frequently switch between the four report views in Access—Layout view, Print Preview, Design view, and Report view.Most of your design work will be done in Layout view, but occasionally, you will need to switch to Design view to apply a more advanced feature, such as a calculated field.
Users of the report will use Print Preview, Print, and occasionally Layout view. There should be no reason for a user to switch to Layout view or Design view.Modifications to the report should be done by the designated report designer.
To switch between the four views, click the View arrow in the Views group and select the desired view. Layout view and Print Preview are the most common views; Report view is useful for filtering a report based on a field value. You can also switch between views by rightclicking on the report tab or by right-clicking a report in the Navigation Pane. You can also click one of the small view icons in the bottom right of the Access window.
Identifying Report Sections
Access reports are divided into five main sections that can be viewed when you display a report in Design view
Identify the Default Report Sections
When in Design view, you can collapse or expand each section as needed, and delete any header or footer section.
The Report Header section prints at the beginning of each report. This section will usually contain the report title, a logo or other graphic, and the date and time when the report was printed. You can remove this section by right-clicking on a section bar, and then clicking the Report Header/Footer option. Follow the same process to add the Report Header/Footer to a report.When you remove the Report Header, the Report Footer is also removed automatically.
The Page Header section appears at the top of each page. Use this section to add or edit column headings on the top of each page. The Page Header will usually contain a horizontal line to separate the column headings from the data values. You can remove this section by right-clicking on a section bar, and then clicking the Page Header/Footer option. Follow the same process to add the Report Header/Footer to a report. If you remove the Page Header, the Page Footer is also removed automatically.
The Detail section prints one line for each record in the report’s record source. Fields that are connected to the report’s record source are known as bound controls. The Detail section can be hidden, if necessary, by clicking Hide Details in the Grouping & Totals group on the Design tab. For reports that only require summarized data, you will want to hide the details. Access makes it easy for you to show or hide detail levels. Click Hide Details again to redisplay hidden details. Although the Detail section cannot be removed from a report, you can hide it from Print Preview, Layout view, and Design view to show only the headers and footers. This is relevant when the output only requires the totals of each category and not the details that make up the category.
The Page Footer section appears at the bottom of each page. Use this section to show page numbers at the bottom of each page. Totals should not be added to this section since the results will produce an error. You can remove this section by right-clicking on a section bar, and the clicking the Page Header/Footer option.Follow the same process to add the Report Header/Footer to a report. If you remove the Page Footer, the Page Header is also removed automatically. 
The Report Footer section prints one time at the bottom of the report. The Report Footer is commonly used for displaying the grand total of certain columns. You can also display the count of all records in the Report Footer section. You can remove this section by right-clicking on a section bar, and then clicking the Report Header/Footer option. Follow the same process to add the Report Header/Footer to a report. If you remove the Report Footer, the Report Header is also removed automatically.
Add a Group Header/Footer
In addition to the five main sections listed above, you can also add a custom group header/footer section to a report. Once you establish the custom group, a Group Header section will appear just above the Detail section in Design view, along with the name of the field you are grouping
A Group Footer section appears just below the Detail section in Design view, but only when you select this option in the Group, Sort, and Total pane
Add Totals to a Group Footer/Report Footer
Revising Reports Using Report Views
Access provides different views for a report similar to the different views in tables, queries, and forms. Tables and queries have Design view and Datasheet view. Forms have Layout view, Form view, and Design view. Reports have Layout view, Print Preview, Design view, and Report view. To switch between certain views, click View in the Views group, or click the View arrow, and then select a view from the list. Each view is described in the sections below.
· Use Layout view to alter the report design while still viewing the data. You should use Layout view to add or delete fields in the report, modify field properties, change the column widths, add grouping and sorting levels to a report, and filter data by excluding certain records.
· Print Preview enables you to see exactly what the report will look like when it is printed.
· Design view displays the report’s design without displaying the data. You can perform many of the same tasks in Design view as you can in Layout view—add and delete fields, add and remove sorting and grouping layers, rearrange columns, adjust column widths, and modify report elements.When a report is very long, Design view is useful because you can alter the design without needing to scroll through pages of data.However, after you make a change in
Design view, it is best to switch to Layout view or Print Preview to examine the final output.
· Report view enables you to see what a printed report will look like in a continuous page layout.
Work with Controls
Bound controls are text boxes that are connected to a field in a table or a query. These controls display different data for each new record that is printed. To add a bound control to a report, switch to Layout view, and then drag a field from the Field List pane onto the report. Unbound controls are labels and other decorative design elements. These controls usually describe and decorate the data rather than display the data. These controls remain the same each time a new record is printed. Unbound controls include labels, lines, borders, and images. Add an unbound control to a report using the Controls group on the Design tab in the Design view of a report. Calculated controls contain an expression that generates a calculated result when displayed in Print Preview. The expression can contain field names from the report’s record source, constants, or functions. Use a text box, found in the Controls group on the Design tab, while in Design view to create a calculated control.
[bookmark: _GoBack]Add a Calculated Control to a Report
To add a calculated control to the report, switch to Design view, and then click Text Box in the Controls group on the Design tab. Place a text box at the desired location, then enter the expression to create the calculation. Format the control as needed. 
